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Introduction 
 

Speech and Debate Timekeeper is a multi-platform timer for various speech and debate 

events. It has speech order and time limits preset for Policy, Lincoln-Douglas, 

Parliamentary, Public Forum, World Schools, Karl Popper, and miscellaneous debate 

formats as well as individual events. 

This timer gives visual and/or spoken time signals at user defined intervals so that you 

will never have to give manual time signals or frequently look at the time. At the end of 

each speech, cross-examination, or preparation, the timer automatically sets itself to time 

the next thing that needs timing at the push of a button. No stopwatch or general purpose 

timer comes this close to fulfilling the role of a dedicated timekeeper in a round. 

Speech and Debate Timekeeper is open source software under the GNU General Public 

License version 2. The license terms are in the file license.txt. The latest release of this 

software is available for free from http://debate-ie-timer.sourceforge.net. 

 

Features 

 Simple stopwatch style interface simultaneously shows time elapsed and remaining. 

Buttons are large so that they can be finger pressed on touch screen PDAs. 

 Visual time signals on a color coded background indicating minutes or seconds 

remaining using a traffic light coloring scheme. 

 Spoken time signals or tones, including protected minute alerts for points of 

information in constructive speeches of Parliamentary debates. 

 Tracks speech order and prep times. Default time limits are set according to the 

selected event and are adjustable. 

 The name of the speech or task being timed is displayed in the title of the window. 

 Navigational buttons set the timer to time the previous or next task. 

 Always-on-top window is useful for keeping time while working in another program 

(e.g., flowing or note taking). 

 High contrast display mode with black text on a white background. 

 Context sensitive help screens are available from drop down menus. 

 

Supported Systems 

 Windows 98/ME, NT, 2000, XP, Vista with Java Runtime Environment 1.3 or higher 

installed. 

 Mac OS X 10.2 or higher. 

 Any Unix or Linux based OS with Java Runtime Environment 1.3 or higher installed. 

 Palm OS 4 or higher handheld devices. 

 Windows CE, Pocket PC, or Windows Mobile PDAs and smartphones. 

http://debate-ie-timer.sourceforge.net/
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Installing Speech and Debate Timekeeper 

Windows 

Speech and Debate Timekeeper was designed to be readily transferable between laptop 

users running different operating systems. Extract the contents of the file which is named 

something like timekeeper-2.x-WinMacUnix.zip, and copy the Timekeeper folder to any 

convenient location such as the desktop, a user’s personal folder, or even a flash drive. 

You will need a Java Runtime Environment (minimum version 1.3) installed on your 

system. Most modern operating systems should have Java already installed by default. It 

can be downloaded for free from http://java.sun.com/j2se/downloads/index.html. 

To start the program, double-click on the file with the clock and gavel icon (Speech 

and Debate Timekeeper.exe). 

 

Mac OS X 

Speech and Debate Timekeeper was designed to be readily transferable between laptop 

users running different operating systems. Extract the contents of the file which is named 

something like timekeeper-2.x-WinMacUnix.zip, and copy the Timekeeper folder to any 

convenient location such as the desktop, a user directory, or even a flash drive. 

To start the program, double-click on the executable JAR file with the coffee cup icon 

(Timekeeper.jar). 

 

Linux & Unix 

Speech and Debate Timekeeper was designed to be readily transferable between laptop 

users running different operating systems. Extract the contents of the file which is named 

something like timekeeper-2.x-WinMacUnix.zip, and copy the Timekeeper folder to any 

convenient location such as the desktop, a user’s home directory, or even a flash drive. 

You will need a Java Runtime Environment (minimum version 1.3) installed on your 

system. Most modern operating systems should have Java already installed by default. It 

can be downloaded for free from http://java.sun.com/j2se/downloads/index.html. 

Clicking on the JAR file may start the program depending on the desktop environment 

or file manager. Otherwise, run the timekeeper shell script by opening a terminal and 

entering: 

./timekeeper 

 

You may first need to make the shell script executable by entering: 

chmod 755 timekeeper 

 

Some desktop environments and file managers may even allow shell script execution 

by double-clicking on them. A KDE and GNOME application launcher is also provided 
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by the file "Speech and Debate Timekeeper.desktop". Click or double-click on it to run 

the program if you copied the Timekeeper folder to your home directory. You may need 

make the launcher point to where it is installed by right clicking on the launcher icon and 

selecting "Properties" or by editing the file in a text editor. In a text editor, change the 

$HOME variable in the Path and Icon entries to the location of the Timekeeper folder. 

 

Palm OS 

Extract the contents of the file which is named something like timekeeper-2.x-palm.zip 

to a convenient location on the computer you use to synchronize with your Palm device. 

Install all of the .prc and .pdb files to your Palm device using the Quick Install program 

that came with your Palm Desktop software. Lastly, perform a HotSync operation. This 

installs Speech & Debate Timekeeper and the SuperWaba virtual machine required to run 

the Timekeeper program. SuperWaba and the Timekeeper program must be installed in 

the device’s main memory. Do not install them on a storage card or you will get an error 

when you try to run the program. 

To start the program, go to where all of your Palm applications are located and tap on 

Timekeeper icon. The SuperWaba virtual machine is automatically started when you run 

the Timekeeper. You do not need start SuperWaba yourself. If you have other 

applications that require SuperWaba, you can download the latest version of SuperWaba 

from http://www.superwaba.com/install. Do not use the ARM versions of SuperWaba for 

Palm OS. The Timekeeper does not work correctly with them. 

 

Windows Mobile 5 & 6 

Extract the contents of the file which is named something like timekeeper-2.x-

windowsmobile.zip to a convenient location on the computer you use to synchronize with 

your Windows Mobile device. Install both .CAB files using ActiveSync (Windows XP 

and earlier) or Windows Mobile Device Center (Windows Vista) according to the 

following steps: 

1. Turn on and connect your PDA to your PC. 

2. In ActiveSync, click on the Explore button or go to the Tools menu and select 

Explore Pocket PC. In Windows Mobile Device Center, click on File Management 

and select “Browse the contents of your device”. Drag both .CAB files into the My 

Documents folder or any convenient location on your Mobile Device. 

3. From the Start menu of your PDA, select File Explorer. Go to the folder on your PDA 

where you copied the .CAB files. 

4. Tap once on the superwaba .CAB file to install the SuperWaba virtual machine. 

When prompted for a location to install it, choose Device. You should get a message 

that says the CAB file was successfully installed. Tap the OK on the upper right to 

continue. 

5. Tap once on the Timekeep .CAB file to install the Timekeeper program. When 

prompted for a location to install it, choose Device. You should get a message that 

http://www.superwaba.com/install
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says the CAB file was successfully installed. Tap the OK on the upper right to 

dismiss the message. 

6. You may delete both CAB files from your PDA after installing them. 

 

SuperWaba and the Timekeeper program must be installed on the device. Do not install 

them on a storage card or you will get an error when you try to run the program. 

To start the program, go to Programs under the Start menu and tap on the Timekeeper 

icon. The SuperWaba virtual machine is automatically started when you run the 

Timekeeper. You do not need start SuperWaba yourself. If you have other applications 

that require SuperWaba, you can download the latest version of SuperWaba from 

http://www.superwaba.com/install. 

 

WinCE, Pocket PC, Windows Mobile 2003 

Extract the contents of the file which is named something like timekeeper-2.x-

pocketpc.zip to a convenient location on the computer you use to synchronize with your 

Pocket PC or Windows Mobile device. There are 3 folders in the .zip file, one for each of 

the supported Pocket PC processors. Open the folder that corresponds with the processor 

(ARM, MIPS, or SH3) in your Pocket PC device. Windows Mobile and most Pocket PCs 

use the ARM processor. Install the .CAB files from that folder using ActiveSync 

(Windows XP and earlier) or Windows Mobile Device Center (Windows Vista) 

according to the following steps: 

1. Turn on and connect your PDA to your PC. 

2. In ActiveSync, click on the Explore button or go to the Tools menu and select 

Explore Pocket PC. In Windows Mobile Device Center, click on File Management 

and select “Browse the contents of your device”. Drag both .CAB files into the My 

Documents folder or any convenient location on your Mobile Device. 

3. From the Start menu of your PDA, select File Explorer. Go to the folder on your PDA 

where you copied the .CAB files. 

4. Tap once on the superwaba .CAB file to install the SuperWaba virtual machine. 

When prompted for a location to install it, choose Device. You should get a message 

that says the CAB file was successfully installed. Tap the OK on the upper right to 

continue. 

5. Tap once on the Timekeep .CAB file to install the Timekeeper program. When 

prompted for a location to install it, choose Device. You should get a message that 

says the CAB file was successfully installed. Tap the OK on the upper right to 

dismiss the message. 

6. You may delete both CAB files from your PDA after installing them. 

 

SuperWaba and the Timekeeper program must be installed on the device. Do not install 

them on a storage card or you will get an error when you try to run the program. 

To start the program, go to Programs under the Start menu and tap on the Timekeeper 

icon. The SuperWaba virtual machine is automatically started when you run the 

Timekeeper. You do not need start SuperWaba yourself. If you have other applications 

http://www.superwaba.com/install
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that require SuperWaba, you can download the latest version of SuperWaba from 

http://www.superwaba.com/install.

http://www.superwaba.com/install
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Uninstalling Speech and Debate Timekeeper 

Windows 

Simply delete the Timekeeper folder and any shortcuts to the program you may have 

created. 

 

Mac OS X 

Simply delete the Timekeeper folder and any shortcuts to the program you may have 

created. 

 

Linux & Unix 

Simply delete the Timekeeper folder and any shortcuts to the program you may have 

created. 

 

Palm OS 

Go to where all of your Palm applications are located and tap on the Menu button. 

Select Delete from the App drop down menu. Select the Timekeeper from the list of 

programs and tap the Delete button. 

If you do not have any other application that needs SuperWaba, you may delete that as 

well. To completely remove SuperWaba, delete SuperWaba and SWNatives using the 

steps described above. 

 

WinCE, Pocket PC, Windows Mobile 

You can remove the software using ActiveSync (Windows XP and earlier) or Windows 

Mobile Device Center (Windows Vista) according to the following steps: 

1. Turn on and connect your PDA to your PC. This should bring up ActiveSync, which 

you would normally use to sync your PDA with your PC. 

2. In ActiveSync, click on Tools in the menu bar and select Add/Remove Programs 

from the drop down menu. In Windows Mobile Device Center, click on Programs and 

Services and select Add/Remove programs. 

3. Clear the check box for “SuperWaba Timekeeper”. If you do not have any other 

application that needs SuperWaba, you may clear the check box for “SuperWaba 

VM” also. 

4. Click the OK button to remove the software with cleared check boxes.
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Using Speech and Debate Timekeeper 

Selecting a Speech or Debate Format 

The standard speech order and time limits are preset for each debate format or speech 

event. When the program starts, it presents event selection lists for the debate formats and 

speech events (Figure 1). Click/tap on the Debates tab for the list of debate formats. 

Click/tap on the Individual Events tab for the list of speech events. Select the desired 

event from the list. The displays from some devices may look different from the 

screenshots below. 

Figure 1 

 
 

Timing Speeches 

After selecting an event, the timer window appears and is ready to time the first speech 

of the selected event (Figure 2). The speech being timed is shown in the black title bar at 

the top of the window. Press the Start button to start time. When the timer is running, the 

Start button becomes the Stop button. When it is stopped, that button becomes the Start 

button. To reset the timer, stop the timer and press the Reset button. To adjust the time 

limit for the current speech, reset the timer and use the + and – buttons in the upper-right 

of the window. 

Figure 2 
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To go to the next speech (or cross examination or prep time), stop the timer and press 

the navigation button on the lower right with the subsequent task labeled in bold. Buttons 

for speeches or tasks that precede the current one have plain labels and appear above the 

button(s) for the subsequent task(s) (Figure 3). If prep time is shown as the next task and 

you want to skip it, simply press its navigation button, and the button for the next speech 

will appear. 

Figure 3 

 
 

You can access the menu bar by clicking/tapping on the Menu button or the black title 

bar. The menus let you set options for time signals, get contextual help, and exit the 

program. Accessing the menu items will not interrupt the timer; if it is running it will 

continue to keep time accurately. 

Note to PDA users: The Timekeeper program temporarily overrides the auto power off 

time on PDAs to prevent it from shutting off while timing an event. You can still 

manually turn off the device using the power button. These programs also temporarily 

disable all hard keys on the device to reduce the chances of accidentally exiting the 

program and resetting the times. The original auto power off and hard key settings are 

restored when you exit the program. 

 

Time Signals 

Time signals are automatically given at specific intervals. Visual time cues are popup 

windows that show the number of minutes remaining on a green background. When less 

than a minute remains, the popup shows the number of seconds remaining on a yellow 

background. Zero on a red background means time's up. See Figure 4 for examples. The 

time cue popup removes itself after some number of seconds. The popup can also be 

dismissed by clicking/tapping on it or by pressing any key. 
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Figure 4 

   
 

Audible time cues may also be given along with the visual cues. There are 3 options for 

audible time cues: Voice, Tone, and None. Audiovisual cues are available for all debates, 

extemporaneous, and impromptu, but not for prepared-speech IE events. There are no 

visual cues for prep times, only audio cues. 

In Parliamentary debates, points of information may be requested after the first minute 

and before the last minute of constructive speeches. These times are indicated by a single 

beep. If Tone is selected for the audio cues, two beeps will be heard. 

 

Customizing Time Signals 

You can change the options for time signals in the Time Signals configuration dialog 

by clicking/tapping on the Menu button and selecting Options from the menu bar then 

Time Signals from the drop down menu (Figure 5). 

Figure 5 

 
 

The Speech/Cross-X tab of the Time Signals configuration dialog controls how time 

signals will be given for speeches and cross examination (Figure 6). The Prep Time tab 

controls how time signals will be given for prep time. The options for audio time signals 

are Voice, Tone, and None. The options for visual time signals are On and Off. The Test 

buttons play demos of a time signal according to the settings in the configuration dialog. 

Click/tap the OK button to accept the settings and close the dialog window. Click/tap the 

Cancel button to cancel any changes and close the dialog window. 
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Figure 6 

  
 

Showing Prep Time on Demand 

Sometimes debaters will ask how much prep time they have left when their prep time is 

not running at the moment. There is no need to use the navigation buttons or interrupt the 

current task being timed to find the prep time for their side. Click/tap on the Menu button 

and select View from the menu bar then Prep Times from the drop down menu to display 

the running prep time for both sides (Figure 7). Alternatively, you can click/tap on the 

View Prep button provided as a shortcut. The Prep Times window only lets you view the 

times; you cannot start, stop, or adjust the time from here. Click the OK button to close 

the window. Note that the View menu also has an Event item that displays the name of 

the current debate format or speech event. 

Figure 7 

  
 

Restarting a Round 

To start a new round or flight of the same event, click/tap on the Menu button and 

select Options from the menu bar then Restart Round from the drop down menu (Figure 

8). This will reset all times, including prep, and go to the first speech. If you adjusted any 

time limits, the time limits you set will be retained when you reset the timer. The time 

limits will revert to their defaults when you exit the program or return to the event 

selection list. 
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Figure 8 

 
 

Other Options 

The High Contrast item under the Options menu (Figure 8) toggles the timer window 

between normal display mode and high contrast display mode. The high contrast mode 

displays black text on a white background which may be easier to read on some devices. 

This does not affect the visual time signals. 

The Main Menu item returns to the event selection lists. The Exit item exits from the 

program. 

 

Getting Help 

Contextual help and other information are available from within the program under the 

Info drop down menu of the menu bar. The menu bar may be activated by 

clicking/tapping on the black title bar of any window (or the Menu button if available). 

The Help item under the Info menu gives contextual help. For example, selecting Help 

from the Info menu at an event selection list will show basic information on the structure 

of each of the listed events. Selecting Help from the Info menu at the Time Signals 

configuration dialog will show information about time signals. 

The About item gives general information about the program such as the version 

number, web site, and contact information. 


